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Room Fire 
This is a more complex example. Although the geometry of the model is relatively simple, the fire is 

ignited by glowing particles that heat the sofa upholstery. The upholstery releases fuel and the fire 

results. As fuel is released, the sofa burns away.  

This approach to modeling a fire pushes the limits of FDS capabilities and is beyond the usual heat 

release rate approach used by fire safety engineers. This detailed approach may be used by researchers 

or forensic investigators. There are large uncertainties of ignition and propagation in this detailed 

approach to modeling. 

This example is a simplification of the room fire problem provided by NIST as an FDS verification 

problem. The simplifications are in the geometry; the material properties and approach to modeling fire 

is the same as used by NIST. We add optional sections that describe using a texture map for a picture 

and sprinklers to extinguish the fire.  

 

Figure 1. Room fire in this example 

This tutorial demonstrates how to: 

• Import properties from a database. 

• Define a combustion reaction. 

• Replicate and rotate obstructions (furniture). 

• Use a hole to represent an open door. 
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• Define an open surface on the exterior of the model. 

• View 3D Results. 

• View 2D results using PyroSim. 

Throughout this example, the instructions will describe data input using menu dialogs. This is done for 

clarity and consistency. However, PyroSim provides both drawing tools and shortcut toolbars that can 

speed many of these tasks. The user is encouraged to experiment with these alternate approaches to 

model creation. 

1. Brief Overview of Fire Modeling 
In PyroSim/FDS, a fire is defined by pyrolysis and combustion: 

1. Pyrolysis – This is the rate at which a solid or liquid surface generates fuel vapor. For example, 

wood is heated and releases combustible gas. 

2. Combustion – This is the reaction of fuel vapor and oxygen. The products are defined by the 

chemical reaction. The fuel vapor results from pyrolysis, oxygen is provided by air. The 

combustion process mixes fuel and oxygen and controls the reaction rate. 

A more complete discussion is given in the FDS User Manual (Pyrolysis in Chapter 8 and Combustion in 

Chapter 12). On the PyroSim web site, the Resources also provide links to a set of videos that further 

explain the details (see PyroSim: Modeling Fire, Part 1 – Reactions, Part 2 - Heat Release Rate, and Part 3 

- Combustion using HRR). 

Standard Approach to Fire Modeling 

The most frequently used approach to modeling a reaction in PyroSim/FDS assumes a single fuel species 

composed of C, H, O, and N that reacts with air to form products H2O, CO2, soot, and CO. The user 

specifies the chemical formula of the fuel (and the yields for soot and CO and hydrogen fraction in soot), 

and PyroSim/FDS calculates the stoichiometric coefficients and heat release rate. 

The most common way to define pyrolysis in PyroSim/FDS is to specify a Heat Release Rate (HRR) on a 

surface. When HRR is specified, FDS uses the heat of combustion defined by the reaction to calculate the 

fuel vapor mass release rate that will result that will result in the desired energy release. 

The most commonly used combustion model in PyroSim/FDS is the “simple chemistry” model, in which 

the reaction of fuel and oxygen is infinitely fast and controlled only by mixing. 

More Complex Solid Phase Pyrolysis used in this Example 

While this example uses the standard approach to define the reaction and combustion, it uses a much 

more complicated approach for the calculation of the solid phase pyrolysis (the conversion of the solid 

to fuel vapor). 

In this example, fuel vapor mass release rate is calculated by simulating solid phase pyrolysis using a 

layered surface and a pyrolysis rate defined by the material properties. Layered surfaces are used so 

that a heat transfer calculation can be performed. The temperature is then used to calculate the solid 
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phase pyrolysis rate. See the FDS User Manual (Pyrolysis in Chapter 8 and Combustion in Chapter 12) for 

more information. 

2. Start a New Model 
To start a new model. 

1. On the File menu, click New. 

2. On the View menu, click Units and select SI to display values using the metric system. 

3. Save the model. On the File menu, click Save and choose a folder. Name the file room fire.psm. 

4. Click OK to save the model. 

3. Reaction 
First, we define the reaction for this simulation. 

1. On the Model menu, click Edit Reactions. 

2. Click Add From Library, select the POLYURETHANE reaction, and move it to the Current Model. 

Click Close.  

3. Click OK to close the Edit Reactions dialog. 

4. Create the Mesh 
The mesh (or meshes) define the computational domain. It is convenient to define the mesh early and 

use it to help create geometry. You can always modify or refine the mesh later. 

In this example we will use mesh cells with a size of 0.10 m. This is geometrically convenient and is 

somewhat smaller than 1/5 of the characteristic diameter (D*) for a 500 kW fire. In this simulation, the 

fire is ignited and grows, so there is not a single value of heat release rate with which to calculate D*. 

It is the responsibility of the analyst to run verification calculations that show the mesh resolution is 

sufficiently small so that the results have converged. This is a compromise. Using mesh cells that are 

smaller by a factor of 2 should decrease error by a factor of 4, but will increase the simulation run time 

by a factor of 16. 

1. On the Model menu, click Edit Meshes. 

2. Click New and then OK to create a new mesh. 

3. In the Min X box, type 0 and in the Max X box, type 5.2. 

4. In the Min Y box, type -0.8 and in the Max Y box, type 4.6. 

5. In the Min Z box, type 0 and in the Max Z box, type 2.4. 

6. In the X Cells box, type 52. 

7. In the Y Cells box, type 54. 

8. In the Z Cells box, type 24. 

9. Click OK to save changes and close the Edit Meshes dialog. 

10. On the View menu, click Reset View to All Objects. 
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5. Import Material Data 
Materials are the building blocks for Surfaces that are used to define the geometry of the model. 

PyroSim includes a database file that provides data and references for the source of the data. We will 

import selected properties from this file.  

1. On the Model menu, click Edit Materials. 

2. Click Add From Library. 

3. Copy the FOAM, GYPSUM, and YELLOW PINE materials from the library into the Current Model. 

4. Close the PyroSim Libraries dialog. 

 

Figure 2. Copy the materials from the library into the current model 

Because this ignition and burn-away simulation is sensitive to material properties, we will edit the 

imported FOAM material to have the same values as used in the NIST room fire example (the GYPSUM 

and YELLOW PINE do not affect the simulation, so we will leave them with the imported properties). To 

edit FOAM: 

1. In the Edit Materials dialog list, click FOAM. 

2. In the Description box, type NIST – Completely Made Up. 

3. In the Density box, type 40. 

4. In the Specific Heat box, type 1. 

5. Click the Pyrolysis tab. 

6. In the Heat of Combustion box, type 30000. 

7. Under Reaction, click Edit. 

8. In the Reference Temperature box, type 300. 

9. Click the Byproducts tab. 
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10. In the Heat of Reaction box, type 800. 

11. In the Composition column, type 1. 

12. In the Residue column select [Species: SPEC] REAC_FUEL. This means that the pyrolysis 

byproducts will be the fuel.  

13. Click OK to close the Edit Pyrolysis Reaction dialog. 

14. Click Apply to save the changes to FOAM. 

The sofa cushions will be made of a thin layer of fabric that covers a foam pad. No default fabric is 

provided in the PyroSim libraries, so we will create one. The values used for this material are the same 

as used in the NIST model. Note – NIST clearly states the fabric properties are not realistic, so should not 

be used for other models without justification. 

To add a new material:  

1. In the Edit Materials click New.  

2. In the Name box, type Fabric. Click OK. 

3. Click the Thermal Properties tab. In the Density box, type 100. Do not change the default values 

for the other Thermal Properties.  

4. Click the Pyrolysis tab. 

5. Select the Heat of Combustion checkbox and in the value box type 15000. 

6. Under Reaction, click Add. 

7. In the Reference Temperature box, type 280.  

8. Click the Byproducts tab. 

9. Select the Heat of Reaction option and in the box, type 1000. The reaction is Endothermic, that 

is, pyrolysis requires energy input to occur. 

10. In the Composition column, type 1. 

11. In the Residue column select [Species: SPEC] REAC_FUEL. This means that the pyrolysis 

byproducts will be the fuel.  

12. Click OK to close the Edit Pyrolysis Reaction dialog. 

13. Click OK to close the Edit Materials dialog. 

6. Create Surfaces 
Materials define physical properties. Solid surfaces can use the material properties to calculate the 

thermal response.  

The floor will be made of yellow pine material. We use a layered surface. Heat transfer through the 

surface uses a back face boundary condition of air at ambient temperature. No pyrolysis reaction is 

defined for the YELLOW PINE material, so the Pine surface will not burn.  

To create the surface: 

1. On the Model menu, click Edit Surfaces. 

2. Click New, give the Surface Name as Pine, select the Surface Type as Layered, and click OK. A 

layered surface will calculate heat conduction into the surface. 
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3. Click on the Appearance box and select psm_wood2.jpg. Click OK to close the Texture dialog. 

4. In the Material Layers tab, in the Thickness column, type 0.01. 

5. The material composition can be defined as a mixture. Click the Edit button. In the Mass 

Fraction column, type 1.0. In the Material column, select YELLOW PINE. Click OK to close the 

Composition dialog. 

6. In the Edit Surfaces dialog, click Apply to save the changes.  

 

Figure 3. Creating the Pine floor surface 

We will use gypsum for the walls: 

1. In the Edit Surfaces dialog, click New. Give the Surface Name as Gypsum, select the Surface 

Type as Layered, and click OK. 

2. Click on the Color box and define a neutral blue color (e.g. RGB of 198, 225, 230 and Alpha 255). 

Click OK to close the Surface Color dialog. 

3. In the Material Layers panel, in the Thickness column, type 0.013. 

4. Click the Edit button. In the Mass Fraction column, type 1.0. In the Material column, select 

GYPSUM. Click OK to close the Composition dialog. 

5. In the Edit Surfaces dialog, click Apply to save the changes. 

The upholstery will have a fabric surface and a foam core: 

1. In the Edit Surfaces dialog, click New. Give the Surface Name as Upholstery, select the Surface 

Type as Layered, and click OK. 
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2. Click on the Color box and select a grey color (e.g. RGB of 120, 116, 110 and Alpha 255). Click OK 

to close the Surface Color dialog. 

3. In the Material Layers we define the two materials for the upholstery. First the fabric. In the 

Thickness column, type 0.002. Click the Edit button. In the Mass Fraction column, type 1.0. In 

the Material column, select Fabric. Click OK to close the Composition dialog. 

4. Now we add the foam. Click Insert Row. In the Thickness column, type 0.1. Click the Edit button. 

In the Mass Fraction column, type 1.0. In the Material column, select FOAM. Click OK to close 

the Composition dialog. You should now have two material layers in the upholstery surface. 

5. Click on the Surface Props tab. In the Backing box, select Insulated. 

6. Click on the Reaction tab. Select Allow the Obstruction to Burn Away. When this option is 

selected, the solid object disappears from the calculation cell by cell as the mass contained by 

each mesh cell is consumed either by the pyrolysis reaction. This option can also be used when 

HRR is prescribed. 

7. In the Edit Surfaces dialog, click Apply to save the changes. 

 

Figure 4: The upholstery has two material layers. 

We will place an initial ignitor object on the sofa. This ignitor will be at a constant temperature of 1000 

°C and will radiate heat that will ignite the upholstery. To create this burner surface: 

1. In the Edit Surfaces dialog, click New. Give the Surface Name as Ignitor, select the Surface Type 

as Heater/Cooler, and click OK. 



 Room Fire  

9 
 

2. In the Thermal tab, in the Boundary Condition Model, select Fixed Temperature. This means 

the surface will stay at a constant temperature. 

3. In the Thermal tab, in the Surface Temperature box, type 1000. Leave the Emissivity at 0.9. 

4. Click the Geometry tab, in the Geometry list, select Cylindrical. In the Radius box, type 0.01; 

select Length and in the box, type 0.15. 

5. In the Edit Surfaces dialog, click OK to save the changes and close the dialog. 

Note that since the ignitor is just a constant surface temperature, we do not need to define any material 

properties for the surface. 

7. Create Furniture (Obstructions) 
We will now add furniture to the model. 

Couch 

The first will be a couch. Create a Couch group that will help us organize the input. 

1. Right-click the Model category in the tree view. 

2. On the Model menu, click New Group. The Parent Group will be Model. 

3. In the Group Name box, type Couch. 

4. Click OK to close the Create Group dialog. 

To create the seat: 

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Seat cushion. 

3. In the Group list, select Couch. 

4. On the Geometry tab, enter the values in Table 1. 

5. On the Surfaces tab, select Single and select Upholstery from the list. 

6. Click OK to close the Obstruction Properties dialog. 

Table 1. Couch seat dimensions 

 X Y Z 

Min 1.5 3.8 0.2 

Max 3.1 4.6 0.6 

 

To create the right armrest: 

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Right armrest. 

3. In the Group list, select Couch. 

4. On the Geometry tab, enter the values in Table 2. 

5. On the Surfaces tab, select Single and select Upholstery from the list. 

6. Click OK to close the Obstruction Properties dialog. 
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Table 2. Right armrest dimensions 

 X Y Z 

Min 1.3 3.8 0.0 

Max 1.5 4.6 0.9 

 

Use the copy function to create the left armrest. 

1. Right-click the Right armrest either in the Tree View or the 3D view. 

2. Click Copy/Move. 

3. In the Mode options, select Copy with 1 copy. 

4. In the Offset boxes, enter X = 1.8, Y = 0.0, and Z = 0.0. 

5. Click OK to close the Translate dialog. 

Double-click on the new Right armrest in the Tree view and change the ID to Left armrest. Click OK. 

To create the back: 

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Back cushion. 

3. In the Group list, select Couch. 

4. On the Geometry tab, enter the values in Table 3. 

5. On the Surfaces tab, select Single and select Upholstery from the list. 

6. Click OK to close the Obstruction Properties dialog. 

Table 3. Couch back dimensions 

 X Y Z 

Min 1.5 4.4 0.6 

Max 3.1 4.6 1.2 

 

The display will appear as shown in Figure 5. 
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Figure 5. The room after the couch is added 

Second Couch 

We will now create a second couch using the copy function. 

1. In the Tree View, right-click the Couch group. 

2. Click Copy/Move. 

3. In the Mode options, select Copy with 1 copy. 

4. In the Offset boxes, enter X = -1.3, Y = -3.6, and Z = 0.0. 

5. Click OK to close the Translate dialog. 

Rotate the second couch to lie against the well. 

1. In the Tree View, right-click the new Couch group. 

2. Click Rotate. 

3. In the Mode options, select Move. 

4. In the Angle box, type 90. 

5. In the Base Point boxes, enter X = 0.0 and Y = 1.0. 

6. Click OK to close the Rotate Objects dialog. 

Additional Furniture 

Add a pad: 

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Pad. 

3. In the Group list, select Model. 

4. On the Geometry tab, enter the values in Table 4. 
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5. On the Surfaces tab, select Single and select Upholstery from the list. 

6. Click OK to close the Obstruction Properties dialog. 

Table 4. Table dimensions 

 X Y Z 

Min 1.6 2.4 0.0 

Max 3.0 3.2 0.2 

 

The resulting room display is shown in Figure 6. 

 

Figure 6. The resulting room display 

Constructing complex objects can be time consuming and PyroSim supports several options. If your 

geometry is available in DXF, DWG, or STL format, PyroSim supports import. You can also import existing 

FDS models. For walls, PyroSim provides sketching on a background image. Alternately, if you use the 

same geometry in many models, you can create the geometry and save it. You can then copy any object 

from one model to another. You can even copy the text from an FDS input file and paste it into a 

PyroSim model. 

8. Walls 
We will add a wall using the 2D View. Since we will be adding only one interior wall, this wall could also 

be added quickly as a single obstruction. However, we will use the 2D view to demonstrate its use. 

1. Select the 2D View. Click the Reset tool. 

2. Select the Wall (  ) Tool. 
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3. Click Tool Properties (  ). In the Name box, type Wall. Set the Z Location to 0.0, the Height to 

2.4, the Thickness to 0.2, and change the Surface Prop to Gypsum. Click OK. 

4. With the wall tool draw the wall from left to right along the Y=0 line. Press the CTRL key to flip 

the wall to the lower part of the model, Figure 7. 

 

 

Figure 7. Drawing the wall 

9. Create Door (Hole in Wall) 
To add a door by creating a hole in the wall: 

1. On the Model menu, click New Hole. 

2. In the ID box, type Door. 

3. In the Group list, select Model. 

4. On the Geometry tab, enter the values in Table 5. Note that we extend the hole beyond the 

bounds of the wall it intersects. This ensures the hole will take priority over the wall. 

5. Click OK to close the Obstruction Properties dialog. 

Table 5. Door dimensions 

 X Y Z 

Min 4.0 -0.3 0.0 

Max 4.9 0.1 2.0 

 

The model now looks like: 
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Figure 8. The model after adding the door 

10. Use Vents to Define the Floor, Walls, and Ceiling 
In FDS, Vents are used to describe 2D planar objects. In this example, we use vents to define the wood 

floor and the gypsum walls and ceiling. We do this because we want the fire to heat the walls and 

ceiling. Recall that the Pine and Gypsum surfaces were layered with the air gap boundary condition.  

To create the floor: 

1. On the Model menu, click New Vent. 

2. In the ID box, type Floor. 

3. In the Group list, select Model. 

4. In the Surface list, select Pine. 

5. Click on the Geometry tab. In the Plane list, select Z and give the value as 0.0. 

6. In the Bounds boxes, enter the values in Table 6. 

7. Click OK to close the Vent Properties dialog. 

Table 6. Floor dimensions 

 X Y 

Min 0.0 -0.8 

Max 5.2 4.6 

 

We want the walls and ceiling to use the Gypsum surface. As we did for the floor, we could define vents 

on the walls and ceiling. However, since these are on the boundary of the model, it is easier to just set 

the Default Surface Type to Gypsum.  
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To define the Default Surface Type: 

1. On the Analysis menu, click Simulation Parameters. 

2. Click the Misc tab. 

3. For the Default Surface Type, select Gypsum. 

4. Click OK to close the Simulation Parameters dialog. 

11. Add Open Boundary 
We will add an open boundary on the model outside the door. PyroSim provides a shortcut that can 

create open vents on mesh boundaries. 

1. In the navigation view, right-click on the MESH01 and click Open Mesh Boundaries. This will add 

a group named Vents for MESH that includes vents on each grid boundary. 

2. Delete four vents, the XMAX, XMIN, YMAX, and ZMIN vents. 

3. Now double-click the Mesh Vent: Mesh [ZMAX] vent. Click the Geometry tab and change Max Y 

to 0. Click OK. 

Now there are just two open vents. One opposite the door and one above the door. This will let smoke 

leave the door and flow up. It will also allow cold air to flow in the lower half of the door. 

12. Create Ignitors that will Light the Fire 
In this model, we will define ignitors that will glow at a fixed temperature, heat the sofa, and ignite the 

sofa. Creating the ignitors is a two-step process: first we define particles, then we position them in the 

model. 

To define the particles: 

1. On the Model menu, click Edit Particles. 

2. Click New. In the Particle Name box, type Ignitor Particle. 

3. In the Particle Type list, select Solid. 

4. Click OK to create the particle. 

5. On the Solid tab, for Surface, select Ignitor (this is the fixed temperature surface we previously 

created. 

6. In the Movement option, select Particles are Stationary. 

7. Click the Injection tab. In the Duration box, type 1E5. This means that the particle will remain in 

the model for the entire simulation. 

8. Click OK to close the Edit Particles dialog. 

Now we will create the actual ignitors. First create an Ignitor group: 

1. Click the Model category in the tree view. 

2. On the Model menu, click New Group. The Parent Group will be Model. 

3. In the Group Name box, type Ignitors. 

4. Click OK to close the Create Group dialog. 
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Now create the first ignitor: 

1. On the Model menu, click New Particle Location. 

2. In the ID box, type Ignitor. 

3. In the Group list, select Ignitors. 

4. In the Particle list, select Ignitor Particle. 

5. In the Droplet Count select Constant and change the number to 1. 

6. Click the Geometry tab. In the Location Properties boxes, enter the values in Table 7. 

7. Click OK to close the Particle Cloud Properties dialog. 

Table 7. Ignitor location 

X Y Z 

2.45 4.35 0.65 

 

Copy to create two more ignitors: 

1. Right-click on the Ignitor and select Copy/Move. 

2. In the Model options, select Copy and in the Number of Copies box, type 2. 

3. In the Offset boxes, enter the values in Table 8. 

4. Click OK to close the Translate dialog. 

Table 8. Ignitor Offsets 

X Y Z 

0.1 0.0 0.0 

 

13. Create Thermocouple Records 
We will first create one thermocouple near the ceiling and then replicate it to create a stack of 

thermocouples. 

1. On the Devices menu, click New Thermocouple. 

2. In the Location boxes, enter X = 2.6, Y = 2.3, and Z = 2.1. 

3. Click OK to close the Thermocouple dialog. 

To copy the thermocouple: 

1. Right-click on THCP and click Copy/Move. 

2. In the Mode, select Copy with the Number of copies 5. 

3. In the Offset boxes, enter X = 0.0, Y =0.0, and Z = -0.3. 

4. Click OK to close the Translate dialog. 

5. Click the LBL icon to toggle labels off. Click the Devices icon to toggle devices off. 
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14. Create Layer Zoning Device 
The upper and lower layers in the room can be calculated using the Layer Zone Device. To create this: 

1. On the Devices menu, click New Layer Zoning Device. 

2. Select the three checkboxes to enable Measure Layer Height, Upper Temperature, and Lower 

Temperature.  

3. In the End Point boxes enter the data in Table 9. 

4. Click OK to close the Layer Zoning Device dialog. 

Table 9. Layer Zone Geometry 

 X Y Z 

End Point 1 2.6 2.3 0 

End Point 2 2.6 2.3 2.4 

 

15. Create Slice Records for Results Plotting 
Slice planes can be used to display 2D contours in the 3D Results display. In this analysis, we will save 

temperature and velocity data for future plotting. To define the slice plane: 

1. On the Output menu, click 2D Slices. 

2. Fill the table by entering the values in Table 10.  

3. Click OK to close the Animated Planar Slices dialog. 

4. In the Toolbar, click Show Slices to toggle display on and off. 

Table 10. Slice plane data 

XYZ Plane Plane Value (m) Gas Phase Quantity Use Vector? Cell Centered? 

X 2.6 Temperature NO NO 

X 2.6 Visibility NO NO 

X 2.6 Velocity YES NO 

X 4.45 Temperature NO NO 

X 4.45 Visibility NO NO 

X 4.45 Velocity YES NO 

16. Create Surface Plots 
Temperatures (and other quantities) on the surface of objects can be plotted. To define the surface 

plots: 

1. On the Output menu, click Boundary Quantities. 

2. Click the Wall Temperature checkbox. 

3. Click OK to close the Animated Boundary Quantities dialog. 

17. Specify Simulation Properties 
To define the end time: 
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1. On the Analysis menu, click Simulation Parameters. 

2. In the Simulation Title box, type Room fire. 

3. In the End Time box, type 100 s. 

4. Click OK. 

18. Hang a Picture on the Wall (Optional) 
Let us fancy things up by hanging a picture on the wall. First decide what picture you want to hang. 

1. On the Model menu, click Edit Surfaces. 

2. In the Edit Surfaces dialog, click New. Give the Surface Name as Picture, select the Surface Type 

as Basic and click OK. (Basic is just an INERT surface that allows you to change the appearance. 

You could also use a layered surface with Gypsum material as we did for the wall.) 

3. Click on the Appearance box. 

4. Click the Import button and select the image you want as a picture. In homage to my Dad and 

Brother, I used the image called motorcycle.jpg. That is me in the middle. Right-click the link and 

click Save Link As to download the image if you would like to use it. 

5. The image you selected will be displayed. Set the Width to 1.0 and the Height to 0.675 (or 

whatever values are appropriate for your image.) 

6. Click OK to close the Textures dialog. 

7. Click OK to close the Edit Surfaces dialog. 

We now create a vent that uses the texture. 

1. On the Model menu, click New Vent. 

2. In the ID box, type Picture. 

3. In the Group list, select Model. 

4. In the Surface list, select Picture. 

5. Under Texture Origin, click to select Relative to Object. 

6. Click the Geometry tab. In the Plane list, select Y and give the value as 4.6. 

7. In the Bounds boxes, enter the values in Table 11. 

8. Click OK to close the Vent Properties dialog. 

Table 11. Picture dimensions 

 X Z 

Min 3.6 1.2 

Max 4.6 1.875 

 

19. Add Sprinklers to Extinguish Fire (Optional) 
We can add a sprinkler that will spray water to extinguish the fire. 

1. On the Devices menu, click New Sprinkler. 

2. Change the Name to Sprinkler. 

http://thunderheadeng.com/downloads/7428
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3. For Temperature Link, select Generic Residential Link. 

4. For Spray Model, select Generic Residential Spray. 

5. In the Location boxes, enter X = 2.6, Y = 2.8, and Z = 2.3. 

6. Click OK to close the Sprinkler dialog. 

20. The Model is Complete 
Your model should now look like Figure 9. Save it. 

 

Figure 9. Completed model 

21. Run the Analysis 
To run the analysis: 

1. On the FDS menu, click Run FDS. If asked to expand holes, click Yes. You will receive a warning 

that two vents overlap. 

22. View the Results 
An image showing the smoke and heat release rate per unit volue is shown in Figure 10. This is a time 

when the sofa has begun to burn, but the fire is still relatively small. You can clearly see the air 
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circulation caused by the fire, with hot air flowing out the top half of the door and cold air flowing in the 

bottom half of the door. The smoke has formed a layer. 

 

Figure 10. Plot showing smoke and fire. You can see the formation of layers, the hot air and products 

flowing out the top of the door, and fresh air flowing in the bottom of the door. 

A plot of surface temperature is given in Figure 11. In this simulation, the sprinkler activated and 

extinguished the fire. However, if you remove the sprinkler and run the simulation for 200 seconds, you 

will see the parts of the sofa burn away.  

Other plot options include the sprinkler particles and slice vectors. When displaying the smoke, right-

click the SOOT MASS FRACTION and click Properties to edit the display. Note that the default options 

are the most realistic rendering of the smoke, but there are times where it helps to reduce the smoke 

opacity to simultaneously display smoke and slices, for example.   
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Figure 11: Plot of surface temperature.  

To view time history results 

1. In the PyroSim toolbar, click Plot Thermal Results. 

2. Plot the heat release rate as a function of time, Figure 12. This simulation included sprinkler 

activation that extinguished the fire. 

3. You can also make plots of the thermocouple readings and the layer height. 

 

Figure 12. Heat release rate. 
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Original NIST FDS Verification Input File 
This example we created is a simplification of the room fire problem provided by NIST as an FDS 

verification problem. You can download the complete original FDS verification file at: 

https://github.com/firemodels/fds/blob/master/Verification/Fires/room_fire.fds  

Save the Raw FDS file. To import the original FDS file into PyroSim, on the File menu, click Import 

FDS/CAD File. During import, specify that the NIST model was created using FDS 6. 

The simplifications we made in the example are mostly related to geometry. 

 


